D3.2.3 Methods for contextual reasoning

Deliverable Co-ordinator: Guilin Qi
Deliverable Co-ordinating Institution: UKARL
Other Authors: Klaas Dellschaft (UKOBL); Qiu Ji (UKARL)

In our previous deliverable D3.1.3, we provided a common formalism for representing context of ontologies. We instantiated our generic definition of context for three specific forms of context: Provenance, Arguments and mapping. In this deliverable, we will further our work in previous deliverable by considering methods for contextual reasoning. We first present a contextual framework for diagnosis and repair. In our framework, we use the RaDON system to debug and diagnose inconsistencies and use the Cicero system to provide a discussion forum to the users. By integrating Cicero with RaDON, the users can utilize the information obtained by discussion in Cicero as context information to come up with a good repair strategy. We then present possibilistic description logics which extend description logics to deal with uncertainty. We show how possibilistic description logics provide an integrated framework to reason with mappings and uncertainty.
<table>
<thead>
<tr>
<th>Document Identifier:</th>
<th>NEON/2009/D3.2.3/v1.0</th>
<th>Date due:</th>
<th>July 30, 2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class Deliverable:</td>
<td>NEON EU-IST-2005-027595</td>
<td>Submission date:</td>
<td>August 14, 2009</td>
</tr>
<tr>
<td>Project start date</td>
<td>March 1, 2006</td>
<td>Version:</td>
<td>v1.0</td>
</tr>
<tr>
<td>Project duration:</td>
<td>4 years</td>
<td>State:</td>
<td>Final</td>
</tr>
<tr>
<td>Distribution:</td>
<td></td>
<td>Distribution:</td>
<td>Public</td>
</tr>
</tbody>
</table>
NeOn Consortium

This document is part of the NeOn research project funded by the IST Programme of the Commission of the European Communities by the grant number IST-2005-027595. The following partners are involved in the project:

<table>
<thead>
<tr>
<th>Open University (OU) – Coordinator</th>
<th>Universität Karlsruhe – TH (UKARL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Media Institute – KMi</td>
<td>Institut für Angewandte Informatik und Formale Beschreibungsverfahren – AIFB</td>
</tr>
<tr>
<td>Berrill Building, Walton Hall</td>
<td>D-76128 Karlsruhe</td>
</tr>
<tr>
<td>Milton Keynes, MK7 6AA</td>
<td>Germany</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>Contact person: Peter Haase</td>
</tr>
<tr>
<td>Contact person: Martin Dzbor, Enrico Motta</td>
<td>E-mail address: <a href="mailto:pha@aifb.uni-karlsruhe.de">pha@aifb.uni-karlsruhe.de</a></td>
</tr>
<tr>
<td>E-mail address: [m.dzbor, e.motta]@open.ac.uk</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Universidad Politécnica de Madrid (UPM)</th>
<th>Software AG (SAG)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campus de Montegancedo</td>
<td>Uhlandstrasse 12</td>
</tr>
<tr>
<td>28660 Boadilla del Monte</td>
<td>64297 Darmstadt</td>
</tr>
<tr>
<td>Spain</td>
<td>Germany</td>
</tr>
<tr>
<td>Contact person: Asunciòn Gómez Pérez</td>
<td>Contact person: Walter Waterfeld</td>
</tr>
<tr>
<td>E-mail address: <a href="mailto:asun@if.ump.es">asun@if.ump.es</a></td>
<td>E-mail address: <a href="mailto:walter.waterfeld@softwareag.com">walter.waterfeld@softwareag.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intelligent Software Components S.A. (ISOCO)</th>
<th>Institut 'Jožef Stefan’ (JSI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calle de Pedro de Valdivia 10</td>
<td>Jamova 39</td>
</tr>
<tr>
<td>28006 Madrid</td>
<td>SL–1000 Ljubljana</td>
</tr>
<tr>
<td>Spain</td>
<td>Slovenia</td>
</tr>
<tr>
<td>Contact person: Jesús Contreras</td>
<td>Contact person: Marko Grobelnik</td>
</tr>
<tr>
<td>E-mail address: <a href="mailto:jcontreras@isoco.com">jcontreras@isoco.com</a></td>
<td>E-mail address: <a href="mailto:marko.grobelnik@ijs.si">marko.grobelnik@ijs.si</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Institut National de Recherche en Informatique et en Automatique (INRIA)</th>
<th>University of Sheffield (USFD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZIRST – 665 avenue de l’Europe</td>
<td>Dept. of Computer Science</td>
</tr>
<tr>
<td>Montbonnot Saint Martin</td>
<td>Regent Court</td>
</tr>
<tr>
<td>38334 Saint-Ismier</td>
<td>211 Portobello street</td>
</tr>
<tr>
<td>France</td>
<td>S14DP Sheffield</td>
</tr>
<tr>
<td>Contact person: Jérôme Euzenat</td>
<td>United Kingdom</td>
</tr>
<tr>
<td>E-mail address: <a href="mailto:j.euzenat@inria.fr">j.euzenat@inria.fr</a></td>
<td>Contact person: Hamish Cunningham</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Universität Kolenz-Landau (UKO-LD)</th>
<th>Consiglio Nazionale delle Ricerche (CNR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universitätsstrasse 1</td>
<td>Institute of cognitive sciences and technologies</td>
</tr>
<tr>
<td>56070 Koblenz</td>
<td>Via S. Marino della Battaglia</td>
</tr>
<tr>
<td>Germany</td>
<td>44 – 00185 Roma-Lazio Italy</td>
</tr>
<tr>
<td>Contact person: Steffen Staab</td>
<td>Contact person: Aldo Gangemi</td>
</tr>
<tr>
<td>E-mail address: <a href="mailto:staab@uni-koblenz.de">staab@uni-koblenz.de</a></td>
<td>E-mail address: <a href="mailto:aldo.gangemi@istc.cnr.it">aldo.gangemi@istc.cnr.it</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ontoprise GmbH. (ONTO)</th>
<th>Food and Agriculture Organization of the United Nations (FAO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amalienbadstr. 36</td>
<td>Viale delle Terme di Caracalla</td>
</tr>
<tr>
<td>(Raumfabrik 29)</td>
<td>00100 Rome</td>
</tr>
<tr>
<td>76227 Karlsruhe</td>
<td>Italy</td>
</tr>
<tr>
<td>Germany</td>
<td>Contact person: Marta Iglesias</td>
</tr>
<tr>
<td>Contact person: Jürgen Angele</td>
<td>E-mail address: <a href="mailto:marta.iglesias@fao.org">marta.iglesias@fao.org</a></td>
</tr>
<tr>
<td>E-mail address: <a href="mailto:angele@ontoprise.de">angele@ontoprise.de</a></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Atos Origin S.A. (ATOS)</th>
<th>Laboratorios KIN, S.A. (KIN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calle de Albarracín, 25</td>
<td>C/Ciudad de Granada, 123</td>
</tr>
<tr>
<td>28037 Madrid</td>
<td>08018 Barcelona</td>
</tr>
<tr>
<td>Spain</td>
<td>Spain</td>
</tr>
<tr>
<td>Contact person: Tomás Pariente Lobo</td>
<td>Contact person: Antonio López</td>
</tr>
<tr>
<td>E-mail address: <a href="mailto:tomas.parientelobo@atosorigin.com">tomas.parientelobo@atosorigin.com</a></td>
<td>E-mail address: <a href="mailto:alopez@kin.es">alopez@kin.es</a></td>
</tr>
</tbody>
</table>
Work package participants

The following partners have taken an active part in the work leading to the elaboration of this document, even if they might not have directly contributed to the writing of this document or its parts:

- UKarl
- UKobl
- Partner X

Change Log

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Amended by</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>31-03-2009</td>
<td>Guilin Qi</td>
<td>Create the deliverable</td>
</tr>
<tr>
<td>0.2</td>
<td>19-05-2009</td>
<td>Klaas Dellschaft</td>
<td>Introduced the chapter about Cicero and extended the chapter about integrating Cicero and RaDON.</td>
</tr>
<tr>
<td>0.3</td>
<td>31-07-2009</td>
<td>Guilin Qi, Qiu Ji</td>
<td>Complete the deliverable</td>
</tr>
<tr>
<td>0.4</td>
<td>14-08-2009</td>
<td>Guilin Qi, Qiu Ji</td>
<td>Address comments from NeOn review</td>
</tr>
</tbody>
</table>
Executive Summary

In our previous deliverable D3.1.3, we provided a common formalism for representing context of ontologies. We instantiated our generic definition of context for three specific forms of context: Provenance, Arguments and mapping.

In this deliverable, we will further our work in previous deliverable by considering methods for contextual reasoning. We present our framework which helps to diagnose and repair collaboratively constructed ontologies. Our framework integrates RaDON, an ontology diagnosis and repair tool, and Cicero, which provides discussion functionality for the ontology developers. In order to capture the changes on the ontologies proposed by RaDON, the user needs to set up an Oyster server. Oyster is a central registry for ontologies which allows for exchanging ontologies, ontology changes and further ontology related metadata. In our case, Oyster is used to capture ontology changes and to propagate them to the other collaborating developers. In our framework, we use the RaDON system to debug and diagnose inconsistencies and use the Cicero system to provide a discussion forum to the users. By integrating Cicero with RaDON, the users can utilize the information obtained by discussion in Cicero as context information to come up with a good repair strategy.

We then present possibilistic description logics which extend description logics to deal with uncertainty and show how possibilistic description logics provide an integrated framework to reason with mappings and uncertainty. We give semantics and syntax of possibilistic description logics. We then define some inference services in possibilistic description logics. We show how inference services in possibilistic description logics can be reduced to the problem of computing the inconsistency degree of the possibilistic description logic-based knowledge base. Since possibilistic inference suffers from the drowning problem, which means that all the axioms whose certainty degrees are lower than the inconsistency degree of the possibilistic description logic-based knowledge base cannot contribute to the inference, we consider a drowning-free variant of possibilistic inference, called linear order inference. We provide an algorithm to compute the inconsistency degree of a possibilistic description logic-based knowledge base and an algorithm for linear ordered inference. Finally, we implement the algorithms and provide a plugin in NeOn toolkit.
Contents

1 Introduction ................................................................. 10
  1.1 Role of WP3 in NeOn Big Picture ........................................... 10
  1.2 Methods for Contextual Reasoning ........................................... 10
  1.3 Overview of the Deliverable .................................................. 11

2 The RaDON System .......................................................... 12
  2.1 Functionalities of RaDON .................................................... 12
  2.2 Process to Debug and Repair Ontology Networks ......................... 12
  2.3 Relevance-directed Algorithm ............................................... 13

3 The Cicero System ........................................................... 14
  3.1 Cicero Argumentation Model ................................................ 14
  3.2 Integration with NeOn Toolkit .............................................. 15
  3.3 Conclusions .................................................................. 15

4 A Contextual Framework for Diagnosis and Repair ....................... 16
  4.1 Motivation ................................................................ 16
  4.2 Our Framework ................................................................ 17
  4.3 Implementation ................................................................ 19
    4.3.1 How to Install ................................................................. 19
    4.3.2 How to Use .................................................................. 19

5 Contextual Reasoning in Possibilistic Description Logics ............... 22
  5.1 Motivation .................................................................. 22
  5.2 Preliminaries ................................................................ 23
    5.2.1 Possibilistic Logic ......................................................... 23
  5.3 Possibilistic Description Logics ............................................. 24
    5.3.1 Syntax .................................................................. 24
    5.3.2 Semantics .................................................................. 24
    5.3.3 Possibilistic inference in possibilistic DLs ....................... 25
    5.3.4 Linear order inference in possibilistic DLs ....................... 25
  5.4 Algorithms for Inference in Possibilistic DLs ........................... 26
  5.5 Reasoning With Distributed Systems in Possibilistic DL ............. 27
  5.6 Implementation ................................................................ 29

6 Conclusion ........................................................................ 32
  6.1 Summary ................................................................... 32
List of Tables
List of Figures

1.1 Relationships between different workpackages in NeOn .............................................. 11
3.1 Prototypical workflow for discussions about the design rationale. ................................. 15
4.1 Workflow of activities in the enhanced ontology editing framework. .............................. 18
4.2 Annotate axioms in RaDON using Cicero ................................................................. 20
4.3 Annotate changes using Cicero ..................................................................................... 21
5.1 Compute inconsistency degree ....................................................................................... 30
5.2 Check certainty degree ................................................................................................. 31
Chapter 1

Introduction

1.1 Role of WP3 in NeOn Big Picture

Real life ontologies and corresponding data are produced by individuals or groups in certain settings for specific purposes. Because of this, they can almost never be considered as something absolute in their semantics and are often inconsistent with ontologies created by other parties under other circumstances. In order to fully utilize networked ontologies, those disagreements must be identified prior to using them for reasoning. Each ontology can be viewed as valid (or appropriate) in a certain context. We are interested in knowledge expressed as a set of assertions and rules. If such a set of assertions is put into a context, then this means that the context alters some of the meaning of the set of assertions. From the theoretical side, we could say that whenever the contextual information is necessary, the target ontology cannot have fully defined static semantics because it depends on some external information which we call context. We could call such ontologies parametric ontologies because their semantics depends on the value of contextual parameters. It is the goal of the work performed in WP3 to develop appropriate techniques for dealing with context. As shown in Figure 1.1, this work belongs to the central part of the research and development WPs in NeOn. One of the key points of this workpackage is to model and provide a formalization of the context. This model will support both a proper representation of the information particular to the context and its formalization that allows reasoning with the modeled context.

1.2 Methods for Contextual Reasoning

In our previous deliverable D3.1.3, we provided a common formalism for representing context of ontologies. We instantiated our generic definition of context for three specific forms of context: Provenance, Arguments and mapping.

In this deliverable, we will further our work in previous deliverable by considering methods for contextual reasoning. We first present a contextual framework for diagnosis and repair. Before presenting the framework, we provide motivation for integrating RaDON and Cicero to show that they can complement each other. We then integrate RaDON and Cicero through NeOn Toolkit and propose an enhanced ontology editing framework. In order to capture the changes on the ontologies proposed by RaDON, the user needs to set up a Oyster server. Oyster is a central registry for ontologies which allows for exchanging ontologies, ontology changes and further ontology related metadata. In our case, Oyster is used to capture ontology changes and to propagate them to the other collaborating developers. In our framework, we use the RaDON system to debug and diagnose inconsistencies and use the Cicero system to provide a discussion forum to the users. By integrating Cicero with RaDON, the users can utilize the information obtained by discussion in Cicero as context information to come up with a good repair strategy.

We then present possibilistic description logics which extend description logics to deal with uncertainty and show how possibilistic description logics provide an integrated framework to reason with mappings and un-
Figure 1.1: Relationships between different workpackages in NeOn

certainty. We give semantics and syntax of possibilistic description logics. We then define some inference services in possibilistic description logics. We show how inference services in possibilistic description logics can be reduced to the problem of computing the inconsistency degree of the description logic-based knowledge base. Since possibilistic inference suffers from the drowning problem, we consider a drowning-free variant of possibilistic inference, called linear order inference. We provide an algorithm to compute the inconsistency degree of a description logic-based and an algorithm for linear ordered inference. Finally, we implement the algorithms and developed a plugin for NeOn toolkit.

The work given in this deliverable is closely related to other activities in WP3. In deliverable D3.8.1, several ontology learning tools are presented. These tools can automatically generate ontologies attached with uncertainty information which can be handled by our possibilistic description logics. In deliverable D3.3.1, the Alignment Server is given as the infrastructure for contextualizing ontologies by finding relations that it has with other ontologies. In our deliverable, we provide possibilistic description logics for reasoning with distributed ontologies connected by mappings.

1.3 Overview of the Deliverable

In this deliverable we first introduce RaDON system and Cicero system in Chapter 2 and Chapter 8 respectively. We then provide a contextual framework for diagnosis and repair in Chapter 4. In Chapter 5, we present possibilistic description logics to reasoning with mappings and uncertainty information. We conclude this deliverable in Chapter 6.
Chapter 2

The RaDON System

RaDON has been developed to deal with inconsistency and incoherence for ontology networks. It supports OWL-DL and is implemented in Java as a plug-in for the NeOn toolkit, which is an extensible ontology engineering environment to handle multiple networked ontologies. The RaDON plugin has already been applied in the FAC case study in the context of diagnosing and repairing automatically learned ontologies. Results of these applications have been reported in NeOn Deliverable D1.2.2 [QHJV07].

In this section, we first introduce the functionalities of the RaDON system and then we present the process to debug and repair ontology networks. Afterwards, we describe the two new algorithms respectively: relevance-directed algorithm and paraconsistency-based algorithm for debugging ontologies.

2.1 Functionalities of RaDON

RaDON provides a set of techniques for dealing with inconsistency and incoherence in ontologies. In particular, RaDON supports novel strategies and consistency models for distributed and networked environments. RaDON extends the capabilities of existing reasoners with the functionalities to deal with inconsistency and incoherence. Specifically, the functionalities provided by RaDON include: (1) debugging an incoherent or inconsistent ontology to explain why a concept is unsatisfiable or why the ontology is inconsistent, (2) repairing an ontology automatically by computing all possible explanations w.r.t. all unsatisfiable concepts if the ontology is incoherent, or w.r.t. the inconsistent ontology if it is inconsistent, (3) repairing an ontology manually based on the debugging results. For the manual repair, the user can choose the axioms to be removed for restoring the coherence or consistency. (4) coping with inconsistency based on a paraconsistency-based algorithm.

2.2 Process to Debug and Repair Ontology Networks

The plug-in can be used to diagnose and repair not only a single ontology, but also multiple ontologies that are networked. In particular, we consider ontologies that are networked via mappings. Mappings essentially are correspondences between the elements of two different ontologies, in the most simple case in the form of subclassOf or equivalentClasses axioms (cf. [HBP+07b] for a definition of the networked ontology model). The mapping assertions may additionally be annotated with confidence values.

RaDON takes as input an ontology network consisting of ontologies and mappings between the ontologies. For our definition of inconsistency in the ontology network, we follow a global model semantics: An ontol-
If the merged ontology is inconsistent, the system computes all the unsatisfiable concepts. When an unsatisfiable concept is selected, all the minimal unsatisfiability-preserving subsets (MUPS){eq}^6\text{w.r.t.} \text{ this concept are computed. Similarly, inconsistencies in the ontology network are debugged: For inconsistencies, all the minimal inconsistent subsets (MIS){eq}^7\text{w.r.t.} \text{ the ontology are computed.}

After obtaining the debugging results, we can repair the ontology automatically according to the proposed solution by our system. Also, the user can repair the ontology by manually choosing the axioms to be removed. To help the user to make a decision, our system provides the confidence values or scores for each axiom which could be removed to resolve incoherence or inconsistency. See [QHJV07] for more details.

### 2.3 Relevance-directed Algorithm

A key problem of diagnosing and repairing ontology networks is to compute all or some MUPS for an unsatisfiable concept efficiently. The RaDON system provides various strategies to compute some or all MUPS based on the relevance-directed algorithm [JQH08]. This algorithm incrementally selects sub-ontologies using a selection function and finds a set of MUPS from these sub-ontologies for an unsatisfiable concept. Our algorithm is adapted from the algorithm given in [KPHS07] which is based on Reiter’s Hitting Set Tree (HST) algorithm [Rei87].

Specifically, the relevance-directed algorithm provides the following strategies when computing MUPS for an unsatisfiable concept:

- Compute one MUPS;
- Compute all MUPS and all hitting sets{eq}^8\text{ for the set of all MUPS;}
- Compute some (not all) MUPS and some hitting sets for the set of all MUPS.

Therefore, the users could choose different strategies according to the ontology and their purpose. For example, if the testing ontology is relatively small, they could try to compute all MUPS. Also, if the users only intend to resolve the incoherence with some but not all solutions, we can choose the third strategy.

---

6Let \( C \) be a named concept which is unsatisfiable in an ontology \( O \). A set \( M \subseteq O \) is a minimal unsatisfiability-preserving subset (MUPS){eq}^6\text{ of } O \text{ if } C \text{ is unsatisfiable in } M, \text{ and } C \text{ is satisfiable in every subset } M' \subseteq M.

7Given an inconsistent ontology \( O \), a set \( M \subseteq O \) is a minimal inconsistent subset (MIS){eq}^7\text{ w.r.t. } O \text{ if } M \text{ is inconsistent and every subset } M' \subseteq M \text{ is consistent.}

8Given a set \( S = \{M_1, ..., M_n\} \) of MUPS of an ontology \( O \) for an unsatisfiable concept, a hitting set \( T \) for \( S \) is a subset of \( O \) such that \( M_i \cap T \neq \emptyset \text{ for all } 1 \leq i \leq n. \)
Chapter 3

The Cicero System

Creating and designing an ontology is a complex task that requires the collaboration of domain and ontology engineering experts. For coming to a consensual model of a domain that is expressed by an ontology, the participants in the engineering process must discuss their different viewpoints in an efficient manner. Furthermore, discussion may become important during resolving inconsistencies in ontologies, especially if there exist several possible solutions. Thus, discussions are an important part of collaborative ontology engineering.

In the context of NeOn, the Cicero tool has been developed that facilitates an asynchronous discussion and decision taking process between participants of an ontology engineering project. Two main objectives of capturing discussions in Cicero can be distinguished:

- **Higher efficiency:** Cicero supports its users in discussing the design rationale of ontologies. The whole discussion including the pro and contra arguments is recorded, leading to fewer redundancies in disputes. It has been shown that the applied discussion methodology facilitates efficient discussions and accelerates convergence to a solution.

- **Enhanced documentation:** The captured discussions reflect the design rationale of an ontology. By attaching a discussion to the entities in the ontology, it is possible later to understand why certain elements are modeled as they are. Furthermore, prior discussions can easily be resumed if e.g. new requirements have to be taken into account.

The first objective is accomplished by the Cicero tool itself\(^1\). Details about its underlying argumentation model and discussion workflow are described in section 3.1 and in [DGG+08]. The second objective is accomplished by integrating Cicero with the NeOn toolkit, which is described in section 3.2.

3.1 Cicero Argumentation Model

The argumentation model, that is underlying the Cicero tool, is based on the DILIGENT argumentation framework [PST04] and the Potts and Bruns model [PB88]. They are both extensions of the idea of the Issue Based Information Systems [KR70, RW73]. All these models help in structuring an issue or problem and to simultaneously derive possible solutions with the help of discussions. In the case of inconsistency reasoning, an issue might e.g. be how to resolve an inconsistency that was detected by RaDON.

The Cicero argumentation model combines the general structure for representing discussions from the DILIGENT argumentation framework with the idea from the Potts and Bruns model of annotating ontology elements and changes with the corresponding discussions. In Cicero, a discussion always starts with an issue that can be raised by either of the participants (i.e. ontology/knowledge engineers or users) e.g. after detecting an inconsistency with RaDON. Subsequently, solutions are proposed and discussed. After some time, it

\(^1\)It can be downloaded from [http://isweb.uni-koblenz.de/Research/Cicero/](http://isweb.uni-koblenz.de/Research/Cicero/). A running instance of Cicero is available at [http://cicero.uni-koblenz.de](http://cicero.uni-koblenz.de).
3.2 Integration with NeOn Toolkit

In order to better support the ontology engineering process, there currently exist three different plugins that integrate functionality of the Cicero wiki into the NeOn toolkit:

1. **Cicero OWL**: Annotating, creating and retrieving discussions related to elements in OWL ontologies.

2. **Cicero OWL Changes**: Annotating creating and retrieving discussions related to adding, removing and editing of elements in OWL ontologies. Integrates Cicero functionality with the Change Capturing plugin.

3. **Cicero FLogic**: Annotating, creating and retrieving discussions related to elements in FLogic ontologies.

All three plugins allow for an easy creation of new discussions and for searching existing discussions from within the NeOn toolkit. For example, if a user of the NeOn toolkit wants to create a new discussion he may select the ontology entities in the environment that should be discussed. Then the corresponding plugin creates a new discussion in the Cicero wiki and annotates the selected ontology entities with the URL of the discussion. The annotation can then be used at a later time to retrieve discussions that are related to specific parts of the ontology.

All above mentioned plugins are available for download on the corresponding page in NeOn toolkit wiki and on the Update Site of the NeOn toolkit that can be directly accessed from within the toolkit. The plugins directly ship with the latest documentation of their functionality which is then available in the help system of the toolkit. Alternatively, the documentation can also be accessed on the page in the NeOn toolkit wiki.

3.3 Conclusions

Altogether, Cicero helps with its IBIS-based argumentation framework to have better structured and more efficient discussions. Furthermore, the integration with the NeOn toolkit leads to a better support of the ontology engineering lifecycle in which discussions about the design rationale of ontology elements play an inherent role. Finally, Cicero and its integration with the NeOn toolkit reduces the required effort for establishing the provenance links between design rationale discussions and the affected ontology elements.
Chapter 4

A Contextual Framework for Diagnosis and Repair

In this chapter, we propose a framework for networked ontology diagnosis and repair by tightly integrating Cicero and RaDON. We first give motivation of our work, then propose our framework. This framework has been implemented as a plugin for NeOn toolkit.

4.1 Motivation

In this section, we discuss the motivation to propose a contextual framework for diagnosis and repair. According to NeOn deliverable D3.1.3, argumentation structures are a form of context that is obtained in collaborative ontology engineering processes. In the case of ontology based argumentation frameworks, DILIGENT [TPSS05] proposes an argumentation ontology that can be used to formally represent the arguments exchanged by ontology engineers in ontology building processes. It is the core of the Cicero framework given in NeOn deliverable D2.3.1 and chapter 3. Some initial experiments have been conducted. Another framework currently under development under the Neon Project is C-ODO [CGL+06]. We have instantiated the generic definition of context by argumentation structure in Section 4.2.2 in D3.1.3.

As described in chapter 3, Cicero is a wiki based solution that supports discussions during a collaborative ontology development project. A typical problem is that conflicting statements may be introduced during collaboratively editing an ontology. The main reason is that an ontology is too complex for foreseeing all possible side-effects of an ontology change.

Several of these side-effects may be detected by discussing the issues and possible solutions with other ontology developers. This especially helps in coming to a consensual understanding of how to best implement a change and how it relates to the already existing ontology. But nevertheless, in very complex or networked ontologies it is impossible for a human to foresee all logical side-effects of a proposed solution that should be implemented and thus during implementing the changes, conflicting or inconsistent statements may be introduced into the ontology.

But even more problematic is the case, when there was no discussion between the developers prior to applying a change. A typical problem in online collaboration is that without good motivation, people are typically reluctant to discuss with each other. A possible reason is that people perceive online discussions as a time-consuming process. Thus, for smaller issues they will not discuss their proposed solution and how to implement it in the ontology. This leads to a higher probability that logical side-effects are overseen and conflicting or inconsistent statements are introduced into the ontology.

In both cases, a debugging system like RaDON helps in detecting the conflicting or inconsistent statements. RaDON provides justifications for the detected conflicts and inconsistencies. Furthermore, it may provide possible solutions for resolving the inconsistencies. By integrating RaDON with Cicero, we may directly feed back the spotted inconsistencies, the justifications and solution proposals of RaDON into the discussions
held in Cicero. There, the ontology developers can then discuss how to cope with the inconsistency and
whether they can adapt one of the solutions proposed by RaDON or whether none of the proposed solutions
is appropriate. Therefore, we can enhance the functionality of Cicero with the help of RaDON.

But not only Cicero and the discussions between the developers may benefit from integration with RaDON. Also a debugging system like RaDON may use information stored in already existing discussions. This information can be used as context information during computing the diagnosis from all minimal unsatisfiability-preserving subsets (MUPS) for an unsatisfiable concept in an ontology (see Chapter 2).

A single diagnosis of RaDON consists of axioms selected from the different MUPS. For example, if we have \(n\) MUPS for an unsatisfiable concept, each of them contains \(m_i\) (\(i = 1, \ldots, n\)) axioms, then there are \(m_1 \times \ldots \times m_n\) different possible diagnoses. In the worst case, RaDON needs to check all of these diagnoses to find a preferred one. Thus, computing all possible diagnoses in RaDON is not very efficient when the number of MUPS is large and the size of each MUPS is big.

A second example is when it comes to repairing an inconsistent ontology. In that case, RaDON typically suggests to remove some axioms from the ontology. However, this removal may not be desirable because the inconsistency may be caused by only parts of an axiom or by a wrong definition of a concept.

In both cases, Cicero may help in semi-automatically solving the problem: For example, in a first step we may ask the user of RaDON to exclude those axioms from the different MUPS that seem to be correct and thus shouldn’t be removed from the ontology. For this purpose, RaDON may show the user the discussions that are attached to the different axioms. This exclusion of axioms from the MUPS can drastically reduce the search space of RaDON for finding a good diagnosis. For example, if there are 3 MUPS which each contain 4 axioms then there are 64 possible diagnoses. If the user is able to exclude 2 axioms from each of the MUPS, then the search space is already reduced to 8 possible diagnoses.

In a second step, the user may decide whether it is possible to weaken some of the axioms in the MUPS instead of completely removing them from the ontology. Again, this decision of the user may be based on the discussions stored in Cicero. Thus, in both steps RaDON may support the decisions of the user by showing him or her all discussions related to the axioms contained in the MUPS.

In both steps, we exploit context information provided by Cicero to deal with inconsistency, thus influence the result of diagnosis and repair.

### 4.2 Our Framework

We integrate RaDON and Cicero through NeOn Toolkit and propose an enhanced ontology editing framework (see Figure 4.1). In order to capture the changes on the ontologies proposed by RaDON, the user needs to set up a Oyster server. Oyster is a central registry for ontologies which allows for exchanging ontologies, ontology changes and further ontology related metadata. In our case, Oyster is used to capture ontology changes and to propagate them to the other collaborating developers. Our framework ensures that possible inconsistencies which were introduced during implementing ontology changes are quickly spotted and resolved in collaboration with the other developers of the ontology.

In our framework, a workflow always starts with a consistent ontology. This ontology may also be empty. For this ontology, first an issue is identified, e.g., the ontology should be extended with new elements or existing elements should be modified. If this issue is explicitly formulated, one may use its description to create an issue in Cicero and discuss possible solutions with the other collaborating developers (see Chapter 3). After the discussion, the developers decided on which of the possible solution proposals should be implemented in response to the issue.

But it is also possible that a developer skips the explicit discussion process in Cicero and thinks about possible solutions himself. Then the single developer thinks about possible solutions for the issue at hand and also decides alone which solution he wants to implement. The advantage of skipping the explicit discussion process in Cicero is that the developer may save time because he needs not to explicitly formulate the issue and the possible solution proposals. But of course this may also be seen as a disadvantage as it increases
the probability that important side effects of the solution are overseen and that the whole process is not well documented.

In any case, after coming to a decision which solution should be implemented, the actual implementation of the changes in the ontology is done. These ontology changes are captured in Oyster. After finishing the implementation of the solution proposal, the user checks with the help of RaDON whether he introduced inconsistencies into the ontology.

If the ontology is consistent, the user accepts the ontology changes and they are propagated to the other developers of the ontology. Otherwise, RaDON will debug the inconsistencies by computing MUPS or MIPS. The MUPS and MIPS are then used by RaDON to generate a set of diagnosis and to help the user in spotting the ontology elements which cause the inconsistency. It is even possible, that RaDON automatically generates solution proposals which would resolve the inconsistencies. Furthermore, RaDON shows the user the discussions in Cicero which are related to the ontology elements contained in the diagnosis. The discussions may be used by the user and/or RaDON to decide which of the ontology elements in the MUPS/MIPS caused the inconsistency and how to resolve it.

Given the output of RaDON, the ontology developer has several choices. For example, he may select one of the automatically generated solution proposals and implement them in the ontology. Furthermore, if there already exists a discussion in Cicero for the current issue, the user may attach the diagnosis of RaDON and/or the possible solution proposals as new contributions to the existing discussion. Finally, if the ontology developer previously skipped the discussion process, he may also take the ontology elements contained in the MUPS and MIPS to either create a discussion of the issue in Cicero now (the newly created discussion is then automatically attached to these ontology elements) or he may try to find a solution without the help of the other collaborating ontology developers.
4.3 Implementation

Our framework has been implemented in NeOn Toolkit by integrating RaDON plug-in, Cicero plug-in and Oyster plug-in. Specifically, Cicero is integrated into RaDON to annotate an axiom in a justification, which facilitates the users to discuss whether an axiom should be removed or not, or to provide the reasons for future discussion. Integrating Cicero to Oyster is to provide the functionality to capture the changes made by RaDON and then annotate the changes.

In this section, we first talk about how to install our framework in NeOn Toolkit. Then we provide the details about how to use our framework.

4.3.1 How to Install

To install our framework, one needs to make sure the NeOn Toolkit 1.2.2 has been installed. Then start NeOn Toolkit and follow the steps below:

1. In NeOn Toolkit, go to “Help” → “Software Updates” → “Find and Install...”.
2. Choose “Search for new features to install” and then click button “Next >”.
3. Choose “NeOn Toolkit Update Site” and then click button “Finish”.
4. Expand the list of “NeOn Toolkit Update Site” and then “diagnose and repair”, afterwards choose “RaDON Changes Feature” and click button “Next >”.
5. Choose “I accept the terms in the license agreement” and then click button “Next >”.
6. Click “Finish”.
7. In the wizard of “Feature Verification”, choose “Install All”.

4.3.2 How to Use

To annotate an axiom or show all relevant issues about the axiom in a justification found by RaDON, please follow the steps below:

1. Start Oyster server by clicking the button of “Oyster Registry” in the tool bar in NeOn Toolkit. Please note that, if you cannot start Oyster server, maybe you could check the following things:
   a) Check whether the port 1099 has been used in your machine or not. If this port has been used, you need to kill it and then start oyster.
   b) If the suggestion above can not resolve the problem, you could try to start Oyster by reading the ontologies locally. To do so, please go to the menu “Window” → “Preferences” → Oyster Storage Preference. In this configuration page, you could choose “Read ontologies locally”.
   c) If you still get the problem, please try to delete the folders of "O2ServerFiles" and "server" in the root directory of NeOnToolkit and then copy the folder of "O2ServerFiles" which is newly downloaded to this directory.

2. Right-click an ontology \( O \) in the ontology navigator and choose “log changes” (Please make sure that you have logged in already. Otherwise, go to “Window” → “Preferences...” and log in in the tab of “Collaborative Development Preference”. Before login, Oyster server should have been launched.).

3. In \( O \)’s “Entity properties” page, input the Cicero project URL in the tab of “Argumentation Settings”.
4. Right-click \( O \) in the ontology navigator and choose “Diagnose and Repair...”.

2006–2009 © Copyright lies with the respective authors and their institutions.
5. If $O$ is incoherent, click the button of “Handle Incoherence” and then click ‘+’ before an unsatisfiable concept to compute its justifications. After this, choose “Repair Manually”.

6. Choose some axioms in the section of “Justifications” to be removed to resolve the incoherence. Then one could annotate the axioms in the section of “Axioms to be removed” by right-clicking an axiom here and choosing an option regarding annotation (see Figure 4.2).

Once some axioms have been moved from an ontology to resolve the incoherence (or inconsistency), one could annotate the changes or show all relevant issues about an change by the following steps:

1. The same steps as steps 1 - 5 above.

2. Confirm the removal. That is, one could choose some axioms in the section of “Axioms to be removed” and then click the button “Confirm Removal”. In such case, the chosen axioms will be removed from the ontology.

3. Open the workflow plug-in by choosing “Window” → “Show view” → “Other...” → “Workflow” → “Draft View”.

4. In the “Draft View”, one could see the changes made in RaDON by clicking the button of “Refresh Changes List”.

5. One could annotate an change or show all its relevant issues by right-clicking an change and choosing a corresponding action (see Figure 4.3).

The users could use the four workflow views (i.e. Draft View, To Be Approved View, Approved View and To Be Deleted View) to manage the changes made by RaDON. In each view, the users can annotate an
change with an issue or show all relevant issues. It is noted that, for different workflow view, different roles are needed to do some changes. For example, for the “Draft View”, only “Subject Expert” can manage the changes here. For other views, “Validator” is needed. The users could change their roles in the tab of “Collaborative Development Preference” in menu “Preferences...” which is a submenu of “Window” in NeOn Toolkit.
Chapter 5

Contextual Reasoning in Possibilistic Description Logics

5.1 Motivation

Provenance is a form of context that is typically available for ontologies. It shows how statements are organized among agents on the web and where the sources of the ontology elements are. In NeOn deliverable D3.1.3, we introduced a model for representing provenance. In this model, we associate with each of the ontology elements a confidence and a relevance value. The confidence value indicates how confident the system is about the correctness of an ontology element. Relevance value denotes the relevance of an ontology element with respect to a particular domain given by a source. We then considered how provenance context can be exploited to deal with inconsistency and uncertainty (see Section 4.1.2 in D3.1.3). We also give explanations on how to use possibilistic OWL to represent and reason with provenance context (see Section 4.1.4 in D3.1.3).

Possibilistic logic [DLP94] or possibility theory offers a convenient tool for handling uncertain or prioritized formulas and coping with inconsistency. It is very powerful to represent partial or incomplete knowledge [BLP04]. There are two different kinds of possibility theory: one is qualitative and the other is quantitative. Qualitative possibility theory is closely related to default theories and belief revision [DP91, BDP92] while quantitative possibility can be related to probability theory and can be viewed as a special case of belief function [DP98].

The application of possibilistic logic to deal with uncertainty in the Semantic Web is first studied in [Hol95] and is then discussed in [DMP08]. When we obtain an ontology using ontology learning techniques, the axioms of the ontology are often attached with confidence degrees and the learned ontology may be inconsistent [HV05]. In this case, possibilistic logic provides a flexible framework to interpret the confidence values and to reason with the inconsistent ontology under uncertainty. Another family of important approaches that extend description logics with uncertainty reasoning are probabilistic description logics [Jae94, Hei94, GL02, DS05, NF04, DP04, KLP97]. We list some major differences between possibilistic extension and probabilistic extension. First, possibilistic description logics are based on possibilistic semantics, thus the notion of consistency is in line with that in classical description logics. In contrast, probabilistic extensions are based on probabilistic measures, thus follow a different definition of consistency. Second, unlike probabilistic logic, the weight attached to an axiom in possibilistic logic is not absolute and can be be replaced by another number as long as the ordering between two weights is not changed. In summary, possibilistic description logics are more flexible than probabilistic ones to deal with inconsistency and qualitative uncertainty.

There exist problems which need further discussion for possibilistic description logics. First, there is no formal definition of the semantics of possibilistic description logics, although a proof method for possibilistic description logics is given. Second, there is no implementation of possibilistic inference given in possibilistic description logics.
In this chapter, we present a possibilistic extension of description logics. We first give the syntax and semantics of possibilistic logics. We then define some inference services in possibilistic description logics. Finally, we implement the algorithms for inference services in possibilistic description logics using KAON2 reasoner.

5.2 Preliminaries

5.2.1 Possibilistic Logic

Possibilistic logic [DLP94] is a weighted logic where each classical logic formula is associated with a number in (0, 1]. Semantically, the most basic and important notion is possibility distribution \( \pi: \Omega \rightarrow [0, 1] \), where \( \Omega \) is the set of all classical interpretations. \( \pi(\omega) \) represents the degree of compatibility of interpretation \( \omega \) with available beliefs. From possibility distribution \( \pi \), two measures can be determined, one is the possibility degree of formula \( \phi \), defined as \( \Pi(\phi) = \max\{\pi(\omega) : \omega \models \phi\} \), the other is the necessity or certainty degree of formula \( \phi \), defined as \( N(\phi) = 1 - \Pi(\neg \phi) \).

At syntactical level, a possibilistic formula is a pair \( (\phi, \alpha) \) consisting of a classical logic formula \( \phi \) and a degree \( \alpha \) expressing certainty or priority. A possibilistic knowledge base is the set of possibilistic formulas of the form \( B = \{(\phi_i, \alpha_i) : i = 1, ..., n\} \). The classical base associated with \( B \), denoted \( B^c \), is defined as \( B^c = \{\phi_i | (\phi_i, \alpha_i) \in B\} \). A possibilistic knowledge base is consistent iff its classical base is consistent.

Given a possibilistic knowledge base \( B \) and \( \alpha \in (0, 1] \), the \( \alpha \)-cut (strict \( \alpha \)-cut) of \( B \) is \( B_{\geq \alpha} = \{\phi \in B^c | (\phi, \beta) \in B \text{ and } \beta \geq \alpha\} \) \( B_{> \alpha} = \{\phi \in B^c | (\phi, \beta) \in B \text{ and } \beta > \alpha\} \). The inconsistency degree of \( B \), denoted \( Inc(B) \), is defined as \( Inc(B) = \max\{\alpha_i : B_{> \alpha_i} \text{ is inconsistent}\} \).

There are two possible definitions of inference in possibilistic logic.

**Definition 1** Let \( B \) be a possibilistic knowledge base.

- A formula \( \phi \) is said to be a plausible consequence of \( B \), denoted by \( B \vdash p \phi \), iff \( B_{\geq Inc(B)} \vdash \phi \).
- A formula \( \phi \) is said to be a possibilistic consequence of \( B \) to degree \( \alpha \), denoted by \( B \vdash \pi(\phi, \alpha) \), iff the following conditions hold: (1) \( B_{> \alpha} \) is consistent, (2) \( B_{\geq \alpha} \vdash \phi \), (3) \( \forall \beta > \alpha, B_{> \beta} \not\vdash \phi \).

According to Definition 1, an inconsistent possibilistic knowledge base can non-trivially infer conclusion, so it is inconsistency tolerant. However, it suffers from the “drowning problem” [BCD+93]. That is, given an inconsistent possibilistic knowledge base \( B \), formulas whose certainty degrees are not larger than \( Inc(B) \) are completely useless for nontrivial deductions. For instance, let \( B = \{(p, 0.9), (\neg p, 0.8), (r, 0.6), (q, 0.7)\} \), it is clear that \( B \) is equivalent to \( B = \{(p, 0.9), (\neg p, 0.8)\} \) because \( Inc(B) = 0.8 \). So \( (q, 0.7) \) and \( (r, 0.6) \) are not used in the possibilistic inference.

Several variants of possibilistic inference have been proposed to avoid the drowning effect. One of them, called linear order inference, is defined as follows.

**Definition 2** Let \( B = \{(\phi_i, \alpha_i) : i = 1, ..., n\} \) be a possibilistic knowledge base. Suppose \( \beta_j (j = 1, ..., k) \) are all distinct weights appearing in \( B \) such that \( \beta_1 > \beta_2 > ... > \beta_k \). Let \( \Sigma_B = (S_1, ..., S_k) \), where \( S_i = \{\phi : (\phi, \alpha) \in B, \alpha = \beta_i\} \), and \( \Sigma_{LO,B} = \bigcup_{i=1}^{k} S_i' \), where \( S_i' \) is defined by \( S_i' = S_i \) if \( S_i \cup \bigcup_{j=1}^{i-1} S_j' \) is consistent, \( \emptyset \) otherwise. A formula \( \phi \) is said to be a linear consequence of \( B \), denoted \( B \vdash_{LO} \phi \), iff \( \Sigma_{LO,B} \vdash \phi \).

The linear order approach does not stop at the inconsistency degree of possibilistic knowledge base \( B \). It takes into account of formulas whose certainty degrees are less than the inconsistency degree.
5.3 Possibilistic Description Logics

5.3.1 Syntax

The syntax of possibilistic DL is based on the syntax of classical DL. A possibilistic axiom is a pair \((\phi, \alpha)\) consisting of an axiom \(\phi\) and a weight \(\alpha \in (0, 1]\). A possibilistic TBox (resp., ABox) is a finite set of possibilistic axioms \(\{\phi, \alpha\}\), where \(\phi\) is an TBox (resp., ABox) axiom. A possibilistic DL knowledge base \(B = (T, A)\) consists of a possibilistic TBox \(T\) and a possibilistic ABox \(A\). We use \(T^*\) to denote the classical DL axioms associated with \(T\), i.e., \(T^* = \{(\phi_i, \alpha_i) \in T\}\) (\(A^*\) can be defined similarly). The classical base \(B^*\) of a possibilistic DL knowledge base is \(B^* = (T^*, A^*)\). A possibilistic DL knowledge base \(B\) is inconsistent if and only if \(B^*\) is inconsistent.

Given a possibilistic DL knowledge base \(B = (T, A)\) and \(\alpha \in (0, 1]\), the \(\alpha\)-cut of \(T\) is \(T_{\geq \alpha} = \{\phi \in B^* \mid (\phi, \beta) \in T \text{ and } \beta \geq \alpha\}\) (the \(\alpha\)-cut of \(A\), denoted as \(A_{\geq \alpha}\), can be defined similarly). The strict \(\alpha\)-cut of \(T\) (resp., \(A\)) can be defined similarly as the strict cut in possibilistic logic. The \(\alpha\)-cut (resp., strict \(\alpha\)-cut) of \(B\) is \(B_{\geq \alpha} = (T_{\geq \alpha}, A_{\geq \alpha})\) (resp., \(B_{>\alpha} = (T_{>\alpha}, A_{>\alpha})\)). The inconsistency degree of \(B\), denoted \(\text{Inc}(B)\), is defined as \(\text{Inc}(B) = \max\{\alpha_i : B_{\geq \alpha_i}\text{ is inconsistent}\}\).

We use the following example as a running example throughout this paper.

**Example 1** Suppose we have a possibilistic DL knowledge base \(B = (T, A)\), where \(T = \{(\text{Eat_fish} \sqsubseteq \text{Swim}, 0.6), (\text{Bird} \sqsubseteq \text{Fly}, 0.8), (\text{HasWing} \sqsubseteq \text{Bird}, 0.95)\}\) and \(A = \{(\text{Bird (chirpy), 1}), (\text{HasWing(tweety), 1}), (\neg \text{Fly(tweety), 1})\}\). The TBox \(T\) states that it is rather certain that birds can fly and it is almost certain that something with wings is a bird. The ABox \(A\) states that it is certain that tweety has wing and it cannot fly, and chirpy is a bird. Let \(\alpha = 0.8\). We then have \(B_{\geq 0.8} = (T_{\geq 0.8}, A_{\geq 0.8})\), where \(T_{\geq 0.8} = \{\text{Bird} \sqsubseteq \text{Fly}, \text{HasWing} \sqsubseteq \text{Bird}\}\) and \(A_{\geq 0.8} = \{\text{HasWing(tweety), } \neg \text{Fly(tweety)}, \text{Bird(chirpy)}\}\). It is clear that \(B_{\geq 0.8}\) is inconsistent. Now let \(\alpha = 0.95\). Then \(B_{\geq 0.95} = (T_{\geq 0.95}, A_{\geq 0.95})\), where \(T_{\geq 0.95} = \{\text{HasWing} \sqsubseteq \text{Bird}\}\) and \(A_{\geq 0.95} = \{\text{HasWing(tweety), } \neg \text{Fly(tweety)}, \text{Bird(chirpy)}\}\). So \(B_{\geq 0.95}\) is consistent. Therefore, \(\text{Inc}(B) = 0.8\).

5.3.2 Semantics

The semantics of possibilistic DL is defined by a possibility distribution \(\pi\) over the set \(I\) of all classical description logic interpretations, i.e., \(\pi : I \rightarrow [0, 1]\). \(\pi(I)\) represents the degree of compatibility of interpretation \(I\) with available information. For two interpretations \(I_1\) and \(I_2\), \(\pi(I_1) > \pi(I_2)\) means that \(I_1\) is preferred to \(I_2\) according to the available information. Given a possibility distribution \(\pi\), we can define the possibility measure \(\Pi\) and necessity measure \(N\) as follows: \(\Pi(\phi) = \max\{\pi(I) : I \in I, I \models \phi\}\) and \(N(\phi) = 1 - \max\{\pi(I) : I \not\models \phi\}\).\(^1\) Unlike possibilistic logic, the necessary measure cannot be not defined by the possibility measure because the negation of an axiom is not defined in traditional DLs. However, given a DL axiom \(\phi\), let us define the negation of \(\phi\) as \(\neg \phi = \exists(C \cap \neg D)\) if \(\phi = C \sqsubseteq D\) and \(\neg \phi = \neg C(\alpha)\) if \(\phi = C(\alpha)\), where \(\exists(C \cap \neg D)\) is an existence axiom (see the discussion of negation of a DL axiom in [FHP+08]), then it is easy to check that \(N(\phi) = 1 - \Pi(\neg \phi)\). Given two possibility distributions \(\pi\) and \(\pi'\), we say that \(\pi\) is more specific (or more informative) than \(\pi'\) iff \(\pi(I) \leq \pi'(I)\) for all \(I \in \Omega\). A possibility distribution \(\pi\) satisfies a possibilistic axiom \((\phi, \alpha)\), denoted \(\pi \models (\phi, \alpha)\), iff \(N(\phi) \geq \alpha\). It satisfies a possibilistic DL knowledge base \(B\), denoted \(\pi \models B\), iff it satisfies all the possibilistic axioms in \(B\).

Given a possibilistic DL knowledge base \(B = (T, A)\), we can define a possibility distribution from it as follows: for all \(I \in I\),

\[
\pi_B(I) = \begin{cases} 
1 & \text{if } \forall \phi \in T^* \cup A^*, I \models \phi_i, \\
1 - \max\{\alpha_i : I \not\models \phi_i, (\phi_i, \alpha_i) \in T \cup A\} & \text{otherwise.}
\end{cases} \tag{5.1}
\]

As in possibilistic logic, we can also show that the possibility distribution defined by Equation 5.1 is the least specific possibility distribution satisfying \(B\). Let us consider Example 1 again. \(I = \langle T^*, A^* \rangle\) is an

\(^1\)The definition of necessity measure is pointed out by one of the reviewers.
interpretation, where $\Delta I = \{\text{tweety, chirpy}\}$ and $\text{Bird} I = \{\text{tweety, chirpy}\}$, $\text{Fly} I = \{\text{chirpy}\}$, and $\text{HasWing} I = \{\text{tweety}\}$. It is clear that $I$ satisfies all the axioms except $\text{Bird} \sqsubseteq \text{Fly}$ (whose weight is 0.8), so $\pi_B(I) = 0.2$.

Let us give some properties of the possibility distribution defined by Equation (5.1).

**Theorem 1** Let $B$ be a possibilistic DL knowledge base and $\pi_B$ be the possibility distribution obtained by Equation (5.1). Then $B$ is consistent if and only if there exists an interpretation $I$ such that $\pi_B(I) = 1$.

**Proposition 1** Let $B$ be a possibilistic DL knowledge base and $\pi_B$ be the possibility distribution obtained by Equation (5.1). Then $\text{Inc}(B) = 1 - \max I \pi_B(I)$.

### 5.3.3 Possibilistic inference in possibilistic DLs

We consider the following inference services in possibilistic DLs.

- Instance checking: an individual $a$ is a plausible instance of a concept $C$ with respect to a possibilistic DL knowledge base $B$, written $B \vdash_P C(a)$, if $B \triangleright \text{Inc}(B) \vdash C(a)$.

- Instance checking with necessity degree: an individual $a$ is an instance of a concept $C$ to degree $\alpha$ with respect to $B$, written $B \vdash_\pi C(a, \alpha)$, if the following conditions hold: (1) $B_{\geq \alpha}$ is consistent, (2) $B_{\geq \alpha} \vdash C(a)$, (3) for all $\beta > \alpha$, $B_{\geq \beta} \not\vdash C(a)$.

- Instance checking with necessity degree: an individual $a$ is an instance of a concept $C$ to degree $\alpha$ with respect to $B$, written $B \vdash_\pi C(a, \alpha)$, if the following conditions hold: (1) $B_{\geq \alpha}$ is consistent, (2) $B_{\geq \alpha} \vdash C(a)$, (3) for all $\beta > \alpha$, $B_{\geq \beta} \not\vdash C(a)$.

- Subsumption with necessity degree: a concept $C$ is subsumed by a concept $D$ to a degree $\alpha$ with respect to a possibilistic DL knowledge base $B$, written $B \vdash_\pi C \sqsubseteq D, \alpha$, if the following conditions hold: (1) $B_{\geq \alpha}$ is consistent, (2) $B_{\geq \alpha} \vdash C \sqsubseteq D$, (3) for all $\beta > \alpha$, $B_{\geq \beta} \not\vdash C \sqsubseteq D$.

We illustrate the inference services by reconsidering Example 1.

**Example 2** (Example 7 continued) According to Example 7, we have $\text{Inc}(B) = 0.8$ and $B_{\geq 0.8} = (T_{0.8}, A_{\geq 0.8})$, where $T_{0.8} = \{\text{HasWing} \sqcap \text{Bird}\}$ and $A_{\geq 0.8} = \{\text{HasWing} (\text{tweety}), \neg \text{Fly (tweety)}, \text{Bird (chirpy)}\}$. Since $B_{\geq 0.8} \vdash \text{Bird} (\text{tweety})$, we can infer that tweety is plausible to be a bird from $B$. Furthermore, since $B_{\geq 0.95} \vdash \text{Bird} (\text{tweety})$ and $B_{\geq 0.95} \not\vdash \text{Bird} (\text{tweety})$, we have $B \vdash_\pi (\text{Bird} (\text{tweety}), 0.95)$. That is, we are almost certain that tweety is a bird.

### 5.3.4 Linear order inference in possibilistic DLs

Possibilistic inference in possibilistic DL inherits the drowning effect of possibilistic inference in possibilistic logic. We adapt and generalize the linear order inference to deal with the drowning problem.

**Definition 3** Let $B = (T, A)$ be a possibilistic DL knowledge base. Suppose $\beta_j (j = 1, \ldots, k)$ are all distinct weights appearing in $B$ such that $\beta_1 > \beta_2 > \ldots > \beta_k$. Let $B'_i = \cup T \cup A$. Let $\Sigma_B = (S_1, \ldots, S_k)$, where $S_i = \{ (\phi_i, \alpha_i) : (\phi_i, \alpha_i) \in B', \alpha_i = \beta_i \}$, and $\Sigma_{LO,B} = \bigcup_{j=1}^{k} S'_j$, where $S'_j$ is defined by $S'_i = S_i$ if $S_i \cup \bigcup_{j=1}^{i-1} S'_j$ is consistent, $\emptyset$ otherwise. Let $\phi$ be a query of the form $C(a)$ or $C \sqsubseteq D$. Then

- $\phi$ is said to be a consequence of $B$ w.r.t. the linear order policy, denoted $B \vdash_{LO} \phi$, iff $(\Sigma_{LO,B})^* \vdash \phi$.
- $\phi$ is said to be a weighted consequence of $B$ to a degree $\alpha$ w.r.t. the linear order policy, denoted $B \vdash_{LO} (\phi, \alpha)$, iff $\Sigma_{LO,B} \vdash_\pi (\phi, \alpha)$.
Algorithm 1: Compute the inconsistency degree

Data: $B = \langle T, A \rangle$, where $T \cup A = \{(\phi_i, \alpha_i) : \alpha_i \in (0, 1], i = 1, ..., n\}$, where $n$ is the number of axioms in the testing ontology $B$;

Result: The inconsistency degree $d$

begin

\begin{align*}
\[ b := 0 \quad & // b is the begin pointer of the binary search \\
\[ m := 0 \quad & // m is the middle pointer of the binary search \\
\[ d := 0.0 \quad & // The initial value of inconsistency degree d is set to be 0.0 \\
\[ W = \text{Asc}(\alpha_1, ..., \alpha_n) \quad & // W is a vector consisting of n distinct numbers \\
\[ W(-1) = 0.0 \quad & // The special element -1 of W is set to be 0.0 \\
\[ e := |W| - 1 \quad & // e is the end pointer of the binary search \\
\end{align*}

if $B \triangleright W(0)$ is consistent then

\begin{align*}
\[ d := 0.0 \quad & // The algorithm requires at most $\lceil \log_2 n \rceil + 1$ satisfiability check using a DL reasoner. \\
\end{align*}

else

\begin{align*}
\text{while } b \leq e & \text{ do} \\
\text{if } b = e & \text{ then} \\
\text{\hspace{1cm} return } b \\
\text{\hspace{1cm} m := \lceil (b + e) / 2 \rceil} \\
\text{\hspace{1cm} if } B \triangleright W(m) is consistent then \\
\text{\hspace{1.5cm} e := m} \\
\text{\hspace{1.5cm} else \\
\text{\hspace{2cm} return } b \\
\text{\hspace{2cm} m := m + 1} \\
\text{\hspace{1.5cm}} d := W(b) \\
\end{align*}

end

In Definition 3, we not only define the consequence of a possibilistic DL knowledge base w.r.t. the linear order policy, but also the weighted consequence of it. The weighted consequence of $B$ is based on the possibilistic inference.

Example 3 (Example 7 continued) Let $\phi = Eat_{fish} \sqsubseteq Swim$. According to Example 2, $\phi$ is not a consequence of $B$ w.r.t. the possibilistic inference. Since $\Sigma_B = (S_1, S_2, S_3, S_4)$, where $S_1 = A$, $S_2 = \{(HasWing \sqsubseteq Bird, 0.95)\}$, $S_3 = \{(Bird \sqsubseteq Fly, 0.8)\}$ and $S_4 = \{(Eat_{fish} \sqsubseteq Swim, 0.6)\}$, we have $\Sigma_{LO,B} = S_1 \cup S_2 \cup S_3 \cup S_4$. It is easy to check that $B \vdash_{LO} (Eat_{fish} \sqsubseteq Swim, 0.6)$.

5.4 Algorithms for Inference in Possibilistic DLs

We give algorithms for the inference in possibilistic DLs. Algorithm 1 computes the inconsistency degree of a possibilistic DL knowledge base using a binary search. The function $\text{Asc}$ takes a finite set of numbers in $(0, 1]$ as input and returns a vector which contains those distinct numbers in the set in an ascending order. For example, $\text{Asc}(0.2, 0.3, 0.3, 0.1) = (0.1, 0.2, 0.3)$. Let $W = (\beta_1, ..., \beta_n)$ be a vector consisting of $n$ distinct numbers, then $W(i)$ denotes $\beta_i$. If the returned inconsistency degree is 0, that is $W(-1) = 0$, it shows the ontology to be queried is consistent.

Since Algorithm 1 is based on binary search, to compute the inconsistency degree, it is easy to check that the algorithm requires at most $\lceil \log_2 n \rceil + 1$ satisfiability check using a DL reasoner.

Algorithm 2 returns the necessity degree of an axiom inferred from a possibilistic DL knowledge base w.r.t. the possibilistic inference. We compute the inconsistency degree of the input ontology. If the axiom is a plausible consequence of a possibilistic DL knowledge base, then we compute its necessity degree using a binary search (see the first “if” condition). Otherwise, its necessity degree is 0, i.e., the default value given to $w$. Note that our algorithm is different from the algorithm given in [Lan00] for computing the necessity of
Algorithm 2: Possibilistic inference with certainty degrees

Data: $B = \langle T, A \rangle$, where $T \cup A = \{ (\phi_i, \alpha_i) : \alpha_i \in (0, 1], i = 1, ..., n \}$; a DL axiom $\phi$.

Result: The certainty degree $w$ associated with a query $\phi$

begin
    $m := 0$
    $w := 0.0$ // The initial certainty degree of $\phi$ is set to be 0.0
    $W = Asc(\alpha_1, ..., \alpha_n)$
    $W(-1) = 0.0$
    $e := |W| - 1$
    compute $l$ such that $W(l) = Inc(B)$ // $Inc(B)$ is computed by Algorithm 1
    $b := l + 1$
    if $B_{>_W(b)} = \phi$ then
        while $b \leq e$ do
            if $b = e$ then
                return $b$
            $m := (b + e)/2$
            if $B_{>_W(m)} \neq \phi$ then
                $e := m - 1$
            else
                $b := m + 1$
        $w := W(b)$
    end
end

a formula in possibilistic logic (this algorithm needs to compute the negation of a formula, which is computationally hard in DLs according to [FHP+06]). We consider only subsumption checking here. However, the algorithm can be easily extended to reduce instance checking as well.

In Algorithm 3, we call Algorithm 1 and Algorithm 2 to compute the certainty degree of the query $\phi$ w.r.t the linear order inference. In the “while” loop, the first “if” condition checks if the inconsistency degree is greater than 0 and then delete the axioms whose necessity degrees are equal to the inconsistency degree. After that, we call Algorithm 1 to compute the inconsistency degree of the initial knowledge base or knowledge base obtained from the first “if” loop. Then the second “if” condition checks if the axiom is a plausible consequence of the possibilistic DL knowledge base and end the “while” loop if the answer is positive. The final “if” condition simply tests if the possibilistic DL knowledge base is consistent or not and terminate the “while” loop if the answer is positive. Finally, we compute the certainty degree of $\phi$ by calling Algorithm 2. This algorithm need to call polynomial times of satisfiability check using a DL reasoner.

Algorithms 2 and 3 compute inference with certainty degree because it is more difficult to obtain the certainty degree of an inferred axiom. They can be easily revised to compute plausible consequence. Because of the page limit, we do not provide the details here.

Proposition 2 Let $B$ be a possibilistic DL knowledge base and $\phi$ be a DL axiom. Deciding whether $B \models_P \phi$ requires $\lceil \log_2 n \rceil + 1$ satisfiability check using a DL reasoner, where $n$ is the number of distinct certainty degrees in $B$. Furthermore, deciding whether $B \models_\pi (\phi, \alpha)$ requires at most $\lceil \log_2 n \rceil + \lceil \log_2 n - 1 \rceil + 1$ satisfiability check using a DL reasoner, where where $n$ is the number of distinct certainty degrees in $B$ and $l$ is the inconsistency degree of $B$.

5.5 Reasoning With Distributed Systems in Possibilistic DL

In this section, we show how we can use possibilistic DL to reason with distributed systems which consists of ontologies and the mappings between them.
Algorithm 3: Linear order inference with certainty degrees

Data: $B = \langle T, A \rangle$, where $T \cup A = \{ (\phi_i, \alpha_i) : \alpha_i \in (0, 1], i = 1, ..., n \}$; a DL axiom $\phi$.

Result: The certainty degree $w$ associated with a query $\phi$

begin
  $d := 0.0$ // The initial inconsistency degree is set to be 0.0
  $w := 0.0$ // The initial certainty degree of $\phi$ is set to be 0.0
  hasAnswer := false
  $W = \text{Asc}(\alpha_1, ..., \alpha_n)$
  $e := |W| - 1$ // $e$ is a global variable to pass values to the subroutines
  while !hasAnswer do
    if $d > 0$ then
      $e := d - 1$
      $B := B \setminus B_d$
      $W := W \setminus d$
      $d := \text{alg}_1(B)$, where $\text{alg}_1$ is Algorithm 1
    if $B_d \models \phi$ then
      hasAnswer := true
    if $d \leq 0$ then
      break
  if hasAnswer then
    $w := \text{alg}_2(B, \phi)$, where $\text{alg}_2$ is Algorithm 2
  end
end

We first introduce the notion of correspondence between elements of two ontologies and mapping defined in [ES07]. Note that our definitions are compatible with the mapping metamodel given in NeOn deliverable D1.1.2 [HBP+07a].

Given two ontologies $O_1$ and $O_2$, describing the same or largely overlapping domains of interest. We can define the correspondences between elements of them.

Definition 4 Let $O_1$ and $O_2$ be two ontologies, $Q$ be a function that defines sets of matchable elements $Q(O_1)$ and $Q(O_2)$. A correspondence is a 4-tuple $\langle e, e', r, \alpha \rangle$ such that $e \in Q(O_1)$ and $e' \in Q(O_2)$, $r$ is a semantic relation, and $\alpha$ is a confidence value from a suitable structure $\langle D, \leq \rangle$.

In Definition 4 there is no restriction on function $Q$, semantic relation $r$ and domain $D$. Similar to the paper [MST07], we only consider correspondences between concepts and restrict $r$ to be one of the semantic relations from the set $\{\equiv, \subseteq, \supseteq\}$, and assume $D = [0.0, 1.0]$.

From a set of correspondences, we can define the notion of a mapping as follows. We follow the definition of a mapping given in [HBP+07a].

Definition 5 Given ontologies $O_1$ and $O_2$, let $Q$ be a function that is given in Definition 4. $M$ is a set of correspondences. Then $M$ is a mapping between $O_1$ and $O_2$ iff for all correspondences $\langle e, e', r, \alpha \rangle \in M$ we have $e \in Q(O_1)$ and $e' \in Q(O_2)$.

That is, a mapping is a set of correspondences whose elements are matchable.

Definition 6 [ZE06] A distributed system is a triple $\mathcal{D} = \langle (O_i), (A_{ij}) \rangle$, consisting of a family of ontologies $(O_i)_{i \in I}$ over a set of indexes $I$ interconnected by a family of alignments $(A_{ij})_{i,j \in I}$. 
Example 4  Take the two ontologies CRS and EKAW in the domain of conference management systems as an example. They contain the following axioms:

- $\text{crs:article} \sqsubseteq \text{crs:document}$
- $\text{ekaw:Paper} \sqsubseteq \text{ekaw:Document}$
- $\text{ekaw:Conference_Paper} \sqsubseteq \text{ekaw:Paper}$
- $\text{ekaw:Conference_Paper} \sqsubseteq \text{ekaw:Document}$
- $\text{ekaw:Workshop_Paper} \sqsubseteq \text{ekaw:Paper}$
- $\text{ekaw:PC_Member} \sqsubseteq \text{ekaw:Possible_Reviewer}$
- $\text{crs:program} \sqsubseteq \neg \text{crs:document}$

We also assume that EKAW contains assertional axioms $\text{ekaw:Workshop_Paper(paper1)}$, $\text{ekaw:Workshop_Paper(paper2)}$. The correspondences in the mapping $A_{12}$ between $O_1$ and $O_2$ are listed as follows:

- $m_1 : (\text{crs:article}, \text{ekaw:Conference_Paper}, \sqsubseteq, 0.65)$
- $m_2 : (\text{ekaw:Workshop_Paper}, \text{crs:article}, \sqsubseteq, 0.65)$
- $m_3 : (\text{ekaw:Document}, \text{crs:program}, \sqsubseteq, 0.80)$
- $m_4 : (\text{crs:program}, \text{ekaw:Document}, \sqsubseteq, 0.80)$
- $m_5 : (\text{crs:document}, \text{ekaw:Document}, \sqsubseteq, 0.93)$

Definition 7  Let $D = ((O_i), (A_{ij}))$ be a distributed system. The union $\bigcup(D)$ of $(O_i)_{i \in I}$ and $(A_{ij})_{i,j \in I}$ is defined as $\bigcup(D) = \bigcup_{i \in I} \{ \phi : \phi \in O_i \} \bigcup \bigcup_{i,j \in I} \{ t(m, \alpha) : m \in A_{ij} \}$ with $t$ being a translation function that converts a correspondence into an axiom in the following way: $t((C, C', r, \alpha)) = C r C'$. That is, we first translate all the correspondences in all the mapping $A_{ij}$ into DL axioms, then the union of the ontologies connected and mappings is the set-union of axioms in ontologies attached with weight 1 and the translated axioms attached with the corresponding weights. This union is a possibilistic DL knowledge base. Take a correspondence in Example 4 as an example, we have $t((\text{crs:article}, \text{ekaw:Conference_Paper}, \sqsubseteq, 0.65)) = \text{crs:article} \sqsubseteq \text{ekaw:Conference_Paper}$. We have $\bigcup(D) = \{ (\text{ekaw:Workshop_Paper(paper1)}, 1), (\text{ekaw:Workshop_Paper(paper2)}, 1), (\text{crs:article} \sqsubseteq \text{crs:document}, 1), (\text{crs:program} \sqsubseteq \neg \text{crs:document}, 1), (\text{ekaw:Paper} \sqsubseteq \text{ekaw:Document}, 1), (\text{ekaw:Workshop_Paper} \sqsubseteq \text{ekaw:Paper}, 1), (\text{ekaw:Conference_Paper} \sqsubseteq \text{ekaw:Paper}, 1), (\text{ekaw:PC_Member} \sqsubseteq \text{ekaw:Possible_Reviewer}, 1), (\text{crs:article} \sqsubseteq \text{ekaw:Conference_Paper}, 0.65), (\text{ekaw:Workshop_Paper} \sqsubseteq \text{crs:article}, 0.65), (\text{crs:Document} \sqsubseteq \text{crs:program}, 0.80), (\text{crs:program} \sqsubseteq \text{ekaw:Document}, 0.80), (\text{crs:document} \sqsubseteq \text{ekaw:Document}, 0.93) \}$. The inconsistency degree of $\bigcup(D)$ is 0.80. By applying possibilistic inference, we can infer that $\text{crs:document}$ is subsumed by $\text{ekaw:Document}$ with degree 0.93.

5.6 Implementation

We have implemented all the algorithms about inference in possibilistic DL as a plug-in in NeOn Toolkit. This plug-in can be used to compute the inconsistency degree for an inconsistent ontology. It also provides the functionalities to do possibilistic inference or linear order inference with certainty degree. In order to handle mapped ontologies, the users are required to merge the ontologies first, then use our system to do inference. Note that our system can only deal with mappings consisting of correspondences attached with different weights.

To install the possibilistic DL plug-in into NeOn Toolkit, the users could follow the similar steps as those for installing the framework in Section 4.3 except Step 4. That is, instead of choosing "RaDON Changes Feature", we should select "Possibilistic DL Feature". After installing possibilistic DL plug-in, the users could right-click an OWL ontology $O$ in the ontology navigator in NeOn Toolkit and then choose the option of "Possibilistic Instance / Subsumption Checking" to show the view. Some information about $O$ (e.g. the number of axioms in the ontology) will be shown in the section of “Ontology Details” in this view. Before we perform any actions in this view, a weight file associated to $O$ needs to be located in the “Weight” tab in “Ontology Details” section.

In order to compute the inconsistency degree, the users could go to the tab of “Configuration” and choose the first option. Usually, the first option is the default one. By clicking the button of “Check Inconsistency” in the section of “Compute Inconsistency Degree”, we can get the answer about whether this ontology is inconsistent or not with the corresponding inconsistency degree. See Figure 5.1 as an example. The ontology is inconsistent and its inconsistency degree is 0.122.
As for possibilistic instance or subsumption checking, we have two different methods: possibilistic inference and linear order inference. The users could choose different methods in the tab of “Configuration” in the Section of “Ontology Details” (see Figure 5.2). After choosing a specific method, the corresponding section will be expanded automatically right below the section of “Ontology Details”. In the newly expanded section, the users could do instance checking or subsumption checking. For example, the users could select one individual and one concept from the corresponding lists and then click the button of “Instance Checking”. If the chosen instance can be inferred that it belongs to the chosen concept, then a weight between 0 and 1 will be shown. Otherwise, the weight is 0. In the example in Figure 5.2, we can infer the individual canal_3 is an individual of concept Canal with certainty degree 0.3 by applying the possibilistic inference.
Figure 5.2: Check certainty degree
Chapter 6

Conclusion

6.1 Summary

In this deliverable, we proposed some methods for contextual reasoning. We first presented a contextual framework for diagnosis and repair. We implemented a system by integrating RaDON and Cicero through NeOn Toolkit and proposed an enhanced ontology editing framework. In our framework, we used the RaDON system to debug and diagnose inconsistencies and used the Cicero system to provide a discussion forum to the users.

We then presented possibilistic description logics which extend description logics to deal with uncertainty. We showed how possibilistic description logics can provide an integrated framework to reason with mappings and uncertainty. We gave semantics and syntax of possibilistic description logics. We then defined several inference services in possibilistic description logics, including a drowning-free variant of possibilistic inference, called linear order inference. We showed how some inference services in possibilistic description logics can be reduced to the problem of computing the inconsistency degree of the description logic-based knowledge base. We provided an algorithm to compute the inconsistency degree of a description logic-based and an algorithm for linear ordered inference. All these algorithm were implemented and a plugin has been developed for NeOn toolkit.

6.2 Roadmap

In our future work, we will consider contextual reasoning based on meta knowledge. Approaches for providing meta knowledge for query answers in relational databases and RDF repositories exist, that are based on algebraic operations. As query answering in description logics in general does not boil down to algebraic evaluation of tree shaped query models, these formalizations do not easily carry over. In this work, we will propose a formalization of meta knowledge which is still algebraic, but allows for reasoning with conflicting and incomplete meta knowledge. The relationship between the new formalism and the existing one in D3.1.3 will be specified. We mainly focus on reasoning with meta knowledge. In D3.2.3, we used pinpointing as a technique to deal with inconsistency. In this work, we will use pinpointing to come up with meta knowledge formulas for description logics, which then can be evaluated algebraically, and describe our prototypical implementation.
Bibliography


